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To register on-line with Sonic Foundry, please follow the steps outlined in the registration 
wizards upon installation of this product.

Registering your product will provide you with technical support, notification of product 
updates, and special promotions exclusive only to Viscosity registered users. 

Registration is required within 7 days of installation or your product will expire.

Sonic Foundry product registration helps protect against software copyright infringement 
and allows us to provide support exclusively to registered users.

If you do not have access to the Internet, registration assistance (in English) is available. 
Please contact our Customer Service Department at:

 Telephone*: 1-800-577-6642 (toll-free) in the US, Canada, and Virgin Islands.
    +800-000-76642 (toll-free) in Australia, Denmark, France, Germany, Italy, 

Sweden, UK, Netherlands, and Japan. 

     +608-256-3133, extension 2300 in all other countries.

E-mail: customerservice@sonicfoundry.com
Fax: 1-608-250-1745

* Registration assistance is available by telephone 24 hours per day, seven days per week.

Sonic Foundry, Inc.
754 Williamson Street
Madison, WI  53703

Sales/Customer Service Only (in 
North America): 1-800-577-6642 
Technical Support: 608-256-5555
Fax: 608-250-1745

Sonic Foundry Europe

PO Box 2903
2601 CX Delft
Netherlands

mailto:customerservice@sonicfoundry.com


The information contained in this manual is subject to change without notice and does not 
represent a commitment on the part of Sonic Foundry. The software described in this 
manual is provided under the terms of a license agreement or non-disclosure agreement. The 
software license agreement specifies the terms and conditions for its lawful use. No part of 
this manual may be reproduced or transmitted in any form or by any means for any purpose 
other than the purchaser’s personal use, without written permission from Sonic Foundry, 
Inc.

Sonic Foundry and Viscosity are trademarks of Sonic Foundry, Inc. The brands and products 
named here are the trademarks or registered trademarks of Sonic Foundry, its affiliates, or 
their respective holders.
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Introduction 
Welcome to Sonic Foundry Viscosity, a pixel-based, 2D-animation software. Viscosity 
combines image editing and animation by allowing you to draw and edit individual frames, 
apply transition and filtering effects, real-time playback for animations, and optimize images 
for the Web.

Viscosity can be used to create animated web site graphics, graphics for multimedia CD-
ROMs, computer based tutorials (CBTs), and video clips. As a result, Viscosity is ideal for 
graphic designers, artists, webmasters, game developers, and video developers who are 
interested in creating or editing graphics and animations. 

System requirements

Your system’s components affect how well Viscosity performs. We recommend the following 
as minimum requirements.

• Microsoft® Windows™ 9x, NT 4.0 or later or Windows 2000
• 200 MHz processor
• 16-bit color display
• 32 MB RAM
• 8 MB hard-disk space for program installation
• CD-ROM drive for product installation
• Internet Explorer™ 4.0 (included on CD-ROM) or later to view online help 
INTRODUCTION
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Technical Support

If you experience problems or have questions while using Viscosity, there are a few ways to 
get the information that you need from Sonic Foundry: Web site support, e-mail support, fax 
support, and telephone support. 

Web site support

Visit our Web site at www.sonicfoundry.com/support. You will find technical information, 
reference information, program updates, tips and tricks, and a Frequently Asked Questions 
(FAQ) archive. 

Email support

Send your questions or comments by using the Technical Support Request form found on 
our web site: www.sonicfoundry.com/support/SupportMail.asp. Our Technical Support 
Department will respond to you within 36 business hours. 

Fax support

Send your questions or comments via fax 24 hours a day at (608) 250-1745. You will receive 
a response within 36 business hours.

Telephone support

Our technical support representatives are available Monday-Friday from 7am to 10pm 
(CST) at (608) 256-5555.

Before You Call Support

Before you contact our technical support department, we ask that you do the following:

• Check to see if your question may be answered in the Start Guide or online help. 
• Use a telephone that is near the computer where Viscosity is installed.
• Make sure you have registered the product. For more information, see Registration on page 8.
INTRODUCTION CHP. 1
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Installing Viscosity

Before you install Viscosity, we recommend that you exit all open programs and temporarily 
disable any virus protection. 

1. Insert the Viscosity CD-ROM. The Viscosity Installation screen appears (if CD-ROM 
AutoPlay is enabled).

If the CD-ROM AutoPlay is disabled, click on the  button and choose Run. 

In the Run window that appears, type the CD-ROM drive’s letter and add :\setup.exe. 
Click the OK button to start the installation.

2. Click Install Software. The installation process begins.

3. Follow the screen prompts and enter the necessary information when required. 

• Use the  button to continue the installation.
• Use the  button to suspend the installation and review previous screen prompts.
• Use the  button to terminate the installation process.

4. At the last screen prompt, click the  button to conclude the installation.

Serial number and activation code

The first time you start Viscosity, the registration dialog appears. You need to enter either 
the serial number or the activation code. Either number will start Viscosity so that you may 
immediately begin your first project.

The serial number allows you to run Viscosity for 7 days. After the 7 days expire, Viscosity 
will time out. If you purchased Viscosity, you can receive your activation code by registering 
either online or by telephone.

Note: If you have started a project and 
Viscosity times out, you will not lose the 
project. It will be available when an activation 
code entered.
CHP. 1 INTRODUCTION
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An activation code is based on the Computer ID number where Viscosity is loaded. Each 
computer has a unique number, similar to a license plate. An activation code is created 
based on that unique number. When you register Viscosity, Sonic Foundry will generate an 
activation code for you. Once the activation code is entered, Viscosity will not time out; it is 
yours. Because the activation code is based on the Computer ID, it is important that you 
have Viscosity loaded on the computer where you will be using it. 

The Computer ID is automatically detected and provided to you when you install Viscosity.

Registration

The Registration dialog that appears when you start Viscosity allows you to quickly and 
easily register to get your activation code. You may register via the Sonic Foundry web site or 
via the telephone. To register, follow the instructions shown in the Registration dialogs.

Using the online help

Viscosity includes HTML online help. To view the online help, you need to have Internet 
Explorer 4.0 or higher loaded on your system (included on the Viscosity CD-ROM).

Accessing help

The online help is accessible by choosing Contents and Index from the Help menu or pressing 
the  key.

Help on the web

Additional Viscosity help and information is available on the Sonic Foundry web site. 
Choose Sonic Foundry on the Web from the Help menu to view a listing of web pages 
pertaining to Viscosity and Sonic Foundry. If your browser is not already open, Viscosity will 
automatically start it for you.

F1
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Overview of Viscosity

This overview will describe the different parts of the interface that appear when Viscosity is 
opened for the first time.

Main window

Startup.gif

The Startup.gif is an interactive tutorial the explains basic functionality and principles 
when using Viscosity. Follow the steps to learn the basics for using Viscosity.

Menu bar

Toolbars:

Work area

Current Color 
Toolbar

Tool Page

Brush Page

Color

Swatches 

Layers Page

(Clock-wise)
Standard
Pages
Selection Tools
Draw Tools

Chooser Page

Page

w/start.gif

Contact links
CHP. 1 INTRODUCTION
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Menu bar

The Menu bar provides access to every aspect of Viscosity: from displaying Toolbars and 
Pages to performing drawing and editing tasks. 

The most commonly used functions have shortcut key assignments displayed next to the 
menu command.

Toolbars

The five Toolbars that appear when you first open Viscosity are the most commonly used. 
Each Toolbar may be moved from its default position to float on the work area or docked to 
different parts of the interface. Simply click and drag the Toolbar to its new position. 

Standard

The Standard toolbar contains buttons used to affect your project as a whole.

Button/Name Description Button/Name Description

 New Accesses the New Document dialog 
used to create a new graphic or 
animation file.

 Paste New Creates a new image file and pastes the 
Clipboard contents to it.

 Open Accesses the Open dialog for 
importing files or opening Viscosity 
files.

 Delete Removes selection from the image. Data 
removed with this command is not added to 
the Clipboard.

 Save Saves current file.  Undo Cancels previous edit and returns image to 
previous state prior to the edit.

 Cut Deletes current selection and adds it 
to the Clipboard.

 Redo Cancels previous Undo command and 
returns the image to the edited state.

 Copy Copies current selection to the 
Clipboard.

 Print Sends image data to the selected printer.

 Paste Inserts Clipboard contents to the 
image.

 Help Access the online help.

Shortcut key
INTRODUCTION CHP. 1
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Pages

The Pages Toolbar toggles the display of all available Viscosity Pages.

Draw Tools

The Draw tools are used for creating and editing images. There are also three mode toggles 
that you may enable: Anti-alias, Eraser, and Auto Selection.

Button/Name Description Button/Name Description

 Tools Displays/hides the Tools Page.  Layers Displays/hides the Layers Page.

 Brushes Displays/hides the Brushes Page.  Color Chooser Displays/hides the Color Chooser Page.

 Outline Displays/hides the Outline Page.  Swatches Displays/hides the Swatches Page.

 Fill Displays/hides the Fill Page.  Color Editor Displays/hides the Color Editor Page.

Button/Name Description Button/Name Description

 Paintbrush

 Line

These tools use the properties set 
on the following pages:

• Brush Page
• Outline Page

Both tools are used for drawing 
lines or strokes.

 Rectangle

 Ellipse

 Polygon

 Closed Shape

 Text

These tools use the properties set on the 
following pages:

• Brush Page
• Outline Page
• Fill Page

These tools create shapes when you click 
and drag the mouse pointer.

 Paint This tool applies the color or filter 
specified on the Fill Page.

 Anti-alias Toggles the use of anti-aliasing. When 
anti-aliasing is on, lines and strokes will 
have smoother edges. 

 Eyedropper This tool samples the selected color 
in the image and adds the it to the 
selected color on the Current Color 
toolbar.

 Eraser Toggles eraser mode that allows you to 
use draw tools as erasers.

 Zoom This tool increases the 
magnification of a selected area. 
Holding down the Ctrl key 
decreases the magnification.

 Auto Selection Toggles selection mode to provide a 
selection marquee to drawn objects.
CHP. 1 INTRODUCTION
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Selection Tools

The Selection tools are useful for editing and creating masks for drawing. By making a 
selection, you may move, copy, paste, and delete images within the selection. Also, 
selections can be used as stencils for drawing.

Current Color

The Current Color Toolbar displays the colors that you chose on the respective color page. 
To change these colors, simply double-click the color and choose a different one from the 
Color dialog or use the Swatches Page.

Button/Name Description Button/Name Description

 Freehand Line

 Line

These tools use all the Outline 
properties for making a selection.

 Text Creates the entered text to form a 
selection.

 Magic Wand Selects similar colored pixels in the image.

 Rectangle Creates a rectangular selection.  Anti-Alias Toggles the use of anti-aliasing selections. 
When anti-aliasing is on, the selection lines 
will have smoother edges. 

 Ellipse Creates a elliptical selection.  Handles mode Toggles the use of handles to appear after 
an object is drawn.

 Polygon Creates a polygonal selection.  Apply Brush Toggles the use of applying the Outline 
Page properties to draw objects.

 Lasso Creates a closed freehand 
selection.

Button Name/Description
The outline properties are set on either the 
Windows Color Picker or on the Outline 
Page.
The fill properties are set on either the 
Windows Color Picker or the Fill Page.
The background color is set when you create 
the image. Double-click the color box to 
change the color from the Windows Color 
Picker or use the Swatches Page.
INTRODUCTION CHP. 1
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Pages

There are five Pages that appear when you first open Viscosity. Each Page may be moved 
from its default position to float on the work area, be docked to different parts of the 
interface, or nested with other Pages. Simply click and drag the Page to its new position. If 
you nest Pages together, click their respective tab to view or change the Page’s properties.

Tool Page

The Tools Page allows you to set properties for the tool that you want to use. From the Tool 
drop-down list, you may specify a tool and set its properties.

Note: The Tools Page contains a drop-down 
list of property presets that can be applied to the 
selected tool. You may also create your own 
preset and save it for later use.

Specify the tool
that you want to use.
CHP. 1 INTRODUCTION
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Brush Page

The Brush Page allows you to set outline properties for the drawing and selection tools. The 
properties set on this page will be used by the Brush, Line, Rectangle, Ellipse, Polygon, and 
Text drawing tools and all the selection tools.

Color Chooser Page

The Color Chooser Page allows you to quickly change the properties of the Outline, Fill, 
and Background colors. On the Current Color Toolbar, click to select Outline, Fill, or 
Background and click on the top pane to set the solid color and then on the lower pane to 
set an opacity value.

Choose or create

Select the 

Set the Brush 
parameters 

Brush Type

a Brush preset

Choose a 
solid color

Set an 
opacity value
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Swatches Page

The Swatches Page also allows you to quickly change the properties of the Outline, Fill, and 
Background colors. On the Current Color Toolbar, click to select Outline, Fill, or 
Background and click on the desired swatch color to apply it.

In addition, this Page contains a drop-down list of Swatch presets. You may also create your 
own preset and save it for later use.

Layers

The Layers Page allows you to separate your image for easier editing and management. You 
may rearrange the layers’ order, merge layers, and set the layers’ opacity from this Page. The 
Layer that has the yellow arrow is the layer to which drawing and selections are applied.

Select a swatch
preset from the 
drop-down list.

Selected layer for 
drawing and editing
CHP. 1 INTRODUCTION
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Creating a new Viscosity file

When starting a new still graphic or animation file, Viscosity allows you to set the file’s 
properties prior to working. Usually, the intended use of the file determines these properties. 
However, you may change the file’s properties at any time.

To create a new still graphic or animation, do the following:

1. Access the New Document dialog in one of the following ways:

• From the File menu, choose New.
• Click the  Toolbar button.
• Press the  shortcut keys.

2. Once the New Document dialog appears, click either the Bitmap or Animation icon.

Note: Bitmap files may be converted to 
animation files.

3. Set the file’s Image, Color, and Animation* Properties or to use the default settings, skip 
to step 4.

The following properties may be changed after the file is open.

4. Click the OK button and Viscosity will create a new image area.

Image Properties
Bit-depth Determines the amount of color that is available for each pixel as you draw.
Width Sets the pixel width for the image area.
Height Sets the pixel height for the image area.
Resolution Sets the sharpness of the image area.

Color
Background color Select the preferred color to use as the backdrop for the image area.
Background opacity Determines the opacity (transparency) for the background color. (If 

the opacity slider is set to 100%, then the background color will be 
solid.)

Animation (*only enabled when animation is selected)
Length Sets the number of frames for the animation.
Frame delay Sets the time delay between frames during animation playback

Ctrl + N
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Importing files into Viscosity

Viscosity allows you to open and edit files in the following formats:

To import a file into Viscosity, do the following:

1. Access the Open dialog by doing one of the following:

• From the File menu, choose Open.
• Click the  Toolbar button.
• Press the  shortcut keys.

2. Navigate to the folder that contains the file that you want to open.

3. Select the file and click the Open button.

Saving the file

The first time you save a graphic or animation to a Viscosity format (*.vsc), the Save As 
dialog will appear. From this dialog, you may specify the file name and location where it will 
be saved. After the initial save, the Save As dialog is bypassed when you save the file.

To save the graphic or animation in the Viscosity format (*.vsc), do the following:

1. Access the Save As dialog in one of the following ways:

• From the File menu, choose Save.
• Click the  Toolbar button.
• Press the  shortcut keys.

2. If this is the first time you are saving the file, the Save As dialog will appear. Specify the 
file’s name and storage location from this dialog.

3. Click the Save button.

Format Description
*.avi Audio and Video Interleave file format is the standard Windows format for video files. 
*.bmp BMP file format is the standard graphic format for Windows applications.
*.gif Graphics Interchange Format file format is the standard graphic format for the Web. Viscosity will 

import both still graphic and animated *.gif files.
*.jpg or 
*.jpeg

Joint Photographic Experts Group file format is used most often for photographic images used on 
the Web.

*.png Portable Network Graphics file format is an alternative to *.gif.
*psd The Adobe Photoshop native file format may be opened, but Viscosity does not currently save to 

this format.
*.vsc The Viscosity native file format preserves all file data: bitmap and animation properties.

Ctrl + O

Ctrl + S
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Exporting to a different format

Viscosity allows you to export the file to a different format. The format that you choose is 
typically determined by the intended use of the graphic or animation.

To export a graphic or animation, do the following:

1. From the File menu, choose Save As. The Save As dialog will appear.

2. On the Save As dialog, enter a new file name and specify a new storage location (if 
necessary).

3. From the Save as file type drop-down list, choose the format to which you want to export 
the file. The options that appear in the drop-down list are determined by whether the file 
is a graphic or an animation.

Note: You may specify the file format’s save 
properties by clicking the Options button.

4. Click the Save button. The file will be saved to the chosen format, file name, and 
location that was specified.

Graphic Export options
*.vsc The Viscosity native format. Select this option for renaming the file.
*.bmp The standard graphic format for Windows applications.
*.gif The standard format for the Web graphics.
*.jpg The format commonly used for Web-based photographic images.
*.png A *.gif alternative graphic format for Web graphics.

Animation Export options
*.avi The standard video format for Windows application. 
*.gif The standard format for animated Web-based images.
INTRODUCTION CHP. 1
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Drawing
Viscosity offers various drawing tools for creating still images and animations. Animations 
that have multiple frames can be drawn on simultaneously by selecting the frames first. For 
more information, see Working with Animations on page 45. 

Draw objects’ and shapes’ appearance is determined by the colors and brush sizes specified 
prior to drawing. Drawing tools’ properties are defined on the Brush and Tool Pages, which 
are used most frequently. Tool settings, brush sizes, and colors determine the appearance of 
shapes in Viscosity. 

We recommend using several layers when creating your artwork. By drawing items on 
separate layers, you make editing the image later much easier. For more information, see 
Working with Layers on page 37.

Using drawing tools

Viscosity Draw tools are as follows: PaintBrush, Line, Rectangle, Ellipse, Polygon, Closed 
Shape, and Text. The shapes color are based on the Current Color bar’s Outline and Fill 
settings. Also, the tools’ brushed outlines are based on the Brush Page’s settings. 

In addition, you control the tools’ shape and appearance from the Tools Page.

Choosing a drawing tool

You may choose a shape by either clicking it on the Drawing toolbar or pressing the shapes 
respective shortcut key.

Tool Shortcut Tool Shortcut

 Paintbrush P  Polygon G

 Line L  Closed Shape H

 Rectangle R  Text T

 Ellipse I
DRAWING
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Setting a tool’s properties

The drawing tools’ properties are set on the Tool Page. On the Tool Page, the chosen 
drawing tool determines what type of controls appear. For example, the Rectangle tool can 
have its angle and corner properties set prior to drawing. 

Note: The PaintBrush, Line, and shape tools’ 
outline properties are set on the Brush Page. 
For more information, see Setting brush and 
line properties on page 25.

The Tool drop-down list allows you to choose a different drawing tool and set its related 
controls prior to drawing. (You may also select a different tool from the Draw Tool toolbar.)

Note: The Tool Page also has a list of Presets. 
Presets are saved settings that allow you to 
quickly configure a drawing tool.

Selected tool’s 
related controls

Set controls prior
to drawing

Tool selection
DRAWING CHP. 2
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Modifying the tool’s shape while drawing

You may use keyboard commands to modify the Rectangle, Ellipse, and Polygon drawing 
tools as they are being drawn.

• The  key anchors the tool in the center and allows you to set its height and width.
• The  key anchors the tool in the center and allows you to constrain the height and 

width while setting the rotation angle. (The Line tool may be rotated in 15 degree 
increments.)

• The  key allows you to move the tool’s shape before applying it to the graphic. Also, if 
you press the  key before you draw a shape and click, the previously draw tool’s shape 
will appear. Release the  key while still holding the mouse button to resize the shape, if 
necessary.

Note: You may use these keys at the same 
time to modify shapes as they are being drawn.

Using outline and fill colors

All drawing tools in Viscosity use and apply the colors selected on the Current Color toolbar 
outline and fill swatches.

This toolbar allows you to set the color properties that the drawing tools will use. The 
Current Color toolbar displays a swatch for the outline and fill colors that you have set.

However, not all drawing tools have both an outline and a fill. Some tools use only an 
outline or a fill. The following table defines each drawing tool and its available properties:

Drawing Tool Properties Used

 Paintbrush Brush and Outline (no Fill)

 Line Brush and Outline (no Fill)

 Rectangle Brush, Outline, and Fill

 Ellipse Brush, Outline, and Fill

 Polygon Brush, Outline, and Fill

 Closed Shape Brush, Outline, and Fill

 Text Brush, Outline, and Fill

 Paint Fill (no Brush or Outline)

Shift

Ctrl

Alt

Alt

Alt

The Outline swatch sets the
color used for drawing tool’s 
that use an outline.
The outline’s brush
properties (width, height,
opacity...) are set on the 
Brush page.
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Setting outline and fill colors

You may set the colors used by the drawing tools by doing the following:

1. On the Current Color toolbar, double-click either the Outline or Fill swatch. The Windows 
Color Picker dialog will appear.

2. Choose a color by doing one of the following:

• Click one of the available swatches.
• Drag the Color matrix slider arrow to set the color’s luminosity.
• Enter custom color values in the Hue, Sat, Lum, Red, Green, or Blue fields. (If you want to 

use the custom color again, click the Add to Custom Colors button to create a custom 
swatch.)

The color that you choose will appear in the Color/Solid display.

3. Click the OK button to apply the color swatch to the Outline or Fill.

Note: You may also set colors using the Color 
Chooser, Swatches, Color Editor, Outline, 
and Fill Pages. Refer to the online help for 
more information.

Color swatches

Custom color
swatches

Current chosen
color display

Color matrix
slider

Custom color
value fields
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Disabling outlines and fills

You may want to draw an object without an outline or a fill color. Outlines and fills may be 
disabled via shortcut menus or keys.

Disabling/enabling outlines

On the Current Color toolbar, click Outline and choose No Outline or press the  shortcut 
key. The Current Color bar will display an icon indicating that outlines have been disabled.

To enable outlines again, click Outline on the Current Color toolbar and choose Solid Color 
or press the  shortcut key. The previously selected swatch will appear.

Disabling/enabling fills

On the Current Color toolbar, click Fill and choose No Fill or press the  shortcut key. 
The Current Color bar will display an icon indicating that fills have been disabled.

To enable fills again, click Fill on the Current Color toolbar and choose Solid Color or press 
the  shortcut key. The previously selected swatch will appear.

X

Outline disabled Outline enabled

C

Shift + X

Fill enabledFill disabled

Shift + C
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Using the Eyedropper and Paint tools

The Eyedropper ( ) and Paint ( ) tools are a quick way to sample and apply colors that 
the Drawing tools will use or to change the Current Color toolbar’s Outline, Fill, or Background 
color swatch.

Using the Eyedropper to sample colors

The Eyedropper tool allows you to take the color from a layer’s image and use it to set the 
swatches on the Current Color toolbar.

To sample color, do the following:

1. On the Current Color toolbar, select the Outline, Fill, or Background swatch to set where the 
sampled color will be applied.

2. Click on the  tool.

3. Click the image color that you want to sample. The color that you select will appear on 
the Current Color toolbar next to the element that you selected in step 1.

4. Repeat steps 1-3 to sample other colors.

Using the Paint tool to apply color

The Paint tool allows you to apply color to similarly colored areas on a layer. The Paint tool’s 
color is based on the Current Color toolbar’s Fill swatch.

To apply color, do the following:

1. Select the  tool.

2. Place the mouse on the area in which you want to apply the fill color and click. All 
adjoining pixels with the same color will change to the new fill color.
DRAWING CHP. 2
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Using brushes and lines

When drawing with the PaintBrush or Line tool, the appearance of the applied brush or line 
is controlled by the Brush Page. In addition, the Rectangle, Ellipse, Polygon, Closed Shape, 
and Text tools’ outline, if applied, uses the settings on the Brush Page.

Setting brush and line properties

The properties that are set on the Brush Page control the appearance of the drawing tools 
that use brush outlines. The Brush Page sets the size, shape, and appearance qualities of 
outlines. The outline’s color is based on the Current Color toolbar’s Outline swatch.

Brush type

The Brush Page also contains a drop-down list of Brush types. You may choose a circular or 
rectangular brush property. The Brush type used in conjunction with the other controls can 
make for interesting brushed outlines.

Brush outline 
controls

Brush type
drop-down

Round brush type

Rectangular brush type

Round brush with steps

Rectangular brush with steps

Rotated rectangular brush with steps
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Brush Page controls

The below table briefly describes how each control changes the properties of brushed lines 
and shape outlines. 

Note: The Brush Page also has a list of 
Presets. Presets are saved settings that allow 
you to quickly configure brush settings.

Control Description
Width Determines the width of the brush.
Height Determines the height of the brush.
Lock sizes Toggles whether the Brush’s width and height is set the same or 

independently.
Opacity Determines the transparency of the brush. A setting of 100% 

indicates fully opaque.
Density Determines the “heaviness” or “fullness” of the brush. A setting of 

100% indicates that the brush will be fully round or rectangular 
depending on the chosen Brush type.

Step Determines the space between the brush segments. The Step 
control is useful for drawing dashed lines with rectangular or 
circular segments. 

Rotation Determines the rotation of the brush.
Hardness Determines the type of “edge” that is applied to the brush. A 

setting of 100% indicates the edge will be fully circular or 
rectangular depending on the chosen Brush type. This control is 
useful for “feathering” a brush.

Brush 
controls

These settings are used for outlines
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Using text

The Text tool allows you to add text to your image or animation. Text may have outline and 
fill colors. The Text tool outline properties are set on Brush Page. The text’s color properties 
are based on the Fill swatch on the Current Color toolbar.

When you select the Text tool, the Tool Page displays the area in which you may enter the 
text. You will see “Sample Text” already entered; simply type over this text. 

Setting text font and properties

By default, Viscosity adds text so that the properties on Brush page and Current Color 
toolbar are applied. You may disable the outline or fill colors prior to adding the text. For 
more information, see Disabling outlines and fills on page 23.

If you intend to use a small font size, the text may appear blurry and compromise readability. 
To increase readability, clear the Vector Outline/Fill check box. The entered text will then use 
only the specified Fill color on the Current Color toolbar.

The Vector Outline/Fill check box toggles the use of vectors when “drawing” text. When this 
check box is cleared, Viscosity will “draw” the text exactly as shown on the Tool Page in 
order to produce sharper font edges.

Select the font and size

Set the font and 

Enter text 

Disables vectors 
when adding text

paragraph format

Outline/Fill

Fill only

Outline only

Vector 
Outline/Fill 
disabled
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Using filters on layers

Filters are effects that transform a layer’s image data. Viscosity offers many filters that may be 
used to affect image data on layer(s). As an example, you could use the Deformation Swirl 
filter to add a whirlpool look to the selected layers.

You will find these filters on the Filters menu. The Filters are divided into groups: Effects, 
Color Adjustments, Deformations, and Render. 

When you select a filter, the associated dialog appears with controls and a preview pane. 
Adjust the controls to achieve the desired look.

To use filters on layers, do the following:

1. On the Layers Page, select the desired layer(s) to which the filter will be applied.

2. From the Filters menu, choose one of the filter types: Effects, Color Adjustment, 
Deformations, or Render. The associated filter dialog appears.

3. In the Layers to Modify area, click the radio button based on the layers that you selected in 
step 1 or to change which layers get the effect.

Note: You may change the filter type from the 
Filter drop-down list. The chosen filter will 
display its associated controls and fields.

4. Set the filter’s properties using the fields and sliders that are associated with it. The 
preview area will update the filter’s effect based on the property settings.

5. Click the OK button to apply the filter to the selected layers.

Note: Each filter dialog has a list of Presets. 
Presets are saved settings that allow you to 
quickly configure filter settings.
DRAWING CHP. 2
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Working with 
Selections
Viscosity offers various selection tools for editing still images and animations. When you use 
one of the selection tools, how the selection appears is based on the Tool and Brush Page 
settings.

A selection defines an area of pixels that will be edited. As a result, we recommend that you 
create your image using several layers. By drawing items on separate layers, selecting items 
and editing the image becomes much easier. For more information, see Working with Layers on 
page 37.

Selections may be moved, copied, pasted, and used for masking (when drawing). Also, you 
may increase or decrease the selection area. 

Using the selection tools

Viscosity has different tools to select portions of the image: Freehand Line, Line, Rectangle, 
Ellipse, Polygon, Lasso, Text, and Magic Wand. With the exception of Magic Wand, the 
selection tools’ shape is based on the Tool and Brush Page settings. 

Choosing a selection tool

You may choose a selection tool by either clicking it on the Selection toolbar or pressing the 
tool’s respective shortcut key.

Tool Shortcut Tool Shortcut

 FreeHand Shift+P  Polygon Shift+G

 Line Shift+L  Lasso Shift+H

 Rectangle Shift+R  Text Shift+T

 Ellipse Shift+I  Magic Wand Shift+N
WORKING WITH SELECTIONS
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Setting a selection tools’ properties

The selection tools’ properties are set on the Tool and Brush Pages. The Tool Page sets the 
shape of a selection tool. Setting the selection tools’ properties is identical to setting the 
Drawing tools properties. However, selection tools do not apply outline or fill colors. For 
more information, see Setting a tool’s properties on page 20. 

The Brush Page sets the size and shape of the Freehand, Line, and outlines for the shape 
selection tools. For more information, see Setting brush and line properties on page 25.

Setting the Selection mode

Viscosity has three modes that affect selections: Anti-alias, Selection handles, and Apply 
brush to selection. These mode buttons appear on the Selection Tools toolbar.

Each mode is a toggle so it is either on or off. The following table defines how each mode 
affects selections.

Making a selection

Use the selection tools to “capture” pixels on an image’s selected layer. When you make a 
selection, a marquee will appear around the selected item(s). All the pixels contained 
within the selection will be available for editing.

To make a selection, do the following:

1. On the Layers Page, select the layer that contains the image that you want to select.

2. Choose one of the selection tools.

3. Enable the selection mode that you want to use, if necessary.

Mode Shortcut Description

 Anti-alias S When enabled, the selection will use anti-aliasing, which produces a 
smoother edge.

 Selection handles Ctrl+H When enabled, the selection will display selection handles. These handles may 
be used to resize the selection.

 Apply brush settings U When enabled, the selection will include the brush properties set on the 
Brush Page. This selection mode is useful for the Freehand and Line tool or 
shape tools with only outline properties. To do this, you disable the fill on the 
Current Color toolbar (pg. 23).

Select a 
layer

Choose a 
Selection tool

Enable a 
Selection mode
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4. Click and drag to make the selection. A marquee will appear around the selection that 
you made.

After the selection is made you may move, copy and paste, or use the selection for drawing. 
When you are finished editing, deselect by pressing the  keys.

Note: When you move a selection, Viscosity 
“floats” if above the other layers. For more 
information, see Floating/defloating the 
selection on page 33.

Modifying the selection tool’s shape

You may use keyboard commands to modify the Rectangle, Ellipse, and Polygon selection 
tools as they are being used. 

• After you begin making the selection, press the  key to anchor the tool in the center 
and set its height and width.

• After you begin making the selection, press the  key to anchor the tool in the center 
and constrain the height and width while setting the rotation angle. (The Line selection 
tool may be rotated in 15 degree increments.)

• The  key allows you to move the selection’s shape before applying it to the graphic. 
Also, if you press the  key before selecting and click, the previous selection shape will 
appear. Release the  key while still holding the mouse button to resize the shape, if 
necessary.

Note: You may use these keys at the same 
time to modify shapes as they are being drawn.

Ctrl + D

Shift

Ctrl

Alt

Alt

Alt
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Using the Magic Wand

The Magic Wand selects similarly colored pixels within the image. For example, you may 
select the color of a solid fill quickly by using the Magic Wand. The Magic Wand’s 
properties, Tolerance, and Adaptive controls are set on the Tool Page.

To make a selection using the Magic Wand, do the following:

1. On the Layers Page, select the layer that contains the image(s) that you want to edit. 

2. Select the Magic Wand by doing one of the following:

• Click the  button on the Selection Tools toolbar.
• Press the  shortcut keys.

3. Place the Magic Wand on the area that you want to select and click. 

A marquee will appear around the selection. After the selection is made you may move, 
copy and paste, or use the selection for drawing. When you are finished editing, deselect by 
pressing the  keys.

Adding to the selection

After a selection is made, you may add to it by using any of the selection tools.

To add to the selection, do the following:

1. Use one of the selection tools and make a selection.

2. Select a different selection tool, if desired.

3. Press and hold the  key.

4. Make another selection. 

5. Release the mouse. The selection marquee will form a new selection area to include both 
selection tools, even if they are non-overlapping, separate selections.

Tool Page Controls Description

Tolerance 
Slider

Specifies the sensitivity of the Magic Wand selection tool; only pixels that 
fall within the color tolerant range will be selected.

Adaptive 
check box

When this check box is disabled, the selection is based on the initial pixel 
color that you clicked and spreads outward until reaching pixel colors 
beyond the specified tolerance range. 

When this check box is enabled, the selection is based on neighboring 
pixels colors where you clicked. The selection spreads and selects 
neighboring pixels until reaching the specified tolerance range. An 
adaptive selection affects a greater area on natural (photographic) 
images.

Shift + N

Ctrl + D

Shift
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Subtracting from the selection

After a selection is made, you may subtract from it by using any of the selection tools.

To subtract from the selection, do the following:

1. Use one of the selection tools and make a selection.

2. Select a different selection tool, if desired.

3. Press and hold the  key.

4. Make another selection that overlaps the existing selection. 

5. Release the mouse. The marquee of the existing selection subtracts the amount that you 
overlapped with the new selection. 

Floating/defloating the selection

You may select a portion of the image and “hover” (float) it above the rest of the image. 
Floating is useful when moving a selection to a different layer of the image. 

Conversely, defloating a selection places it back within the image on the layer that is 
highlighted on the Layers Page.

A floating selection’s marquee is blue and gray whereas a defloated selection’s marquee is red 
and gray. 

To float a selection, do the following:

1. On the Layers page, click the layer that contains the image you want to float.

2. Using one of the selection tools, click and drag the tool so that the image data is within 
the marquee selection.

3. From the Selection menu, choose Float or move the selection and Viscosity floats it over 
the other layers.

4. Select the layer to which you want to assign the selection on the Layers Page.

5. Defloat the selection by choosing Defloat from the Selection menu or press  to 
deselect it.

Ctrl

Ctrl + D
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Editing the selection

Selections contain the pixels that you want to edit. Whether is it moving the selection, 
copying, or deleting it, remember that the edits to the selection are affecting the pixels 
within it.

Moving the selection

After a selection is made, you may move it to a different location in the image using any of 
the selection tools. Moving a selection automatically floats it.

To move a selection, do the following:

1. Click one of the selection tools.

2. Place the mouse pointer on the selection. The Move ( ) cursor will appear.

3. Click and drag the selection to the desired position.

4. Click outside the selection or press the  keys to deselect.

Note: You may use the keyboard’s arrow keys 
to move the selection. In addition, pressing the 

 key allows you to move the selection’s 
boundaries without moving its contents.

Copying and Pasting the selection

You may copy and paste selections on the same layer or paste them to different layers.

To copy and paste a selection, do the following:

1. After the selection is made, copy it by clicking the  button or pressing the  keys.

2. Paste the selection by clicking the  button or pressing the  keys. The selection 
will be pasted and floated on the image. 

3. Select the layer to which the pasted selection will be defloated, if necessary.

4. Click outside the selection or press the  keys to deselect.

Ctrl + D

Alt

Ctrl + C

Ctrl + V

Ctrl + D
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Resizing the selection

After a selection is made, you may resize the selected area using the handles. The Selection 
Handles toggle ( ), when enabled, will automatically display the Selection handles.

To resize the selection, do the following:

1. Place the mouse pointer over one of the selection handles. Depending on the handle, the 
respective Resize ( , , ) cursor will appear.

2. Click and drag the handle to the desired position. As you begin to resize, press the 
following keys to modify the selection.

• The  key resizes from the center of the selection. 
• The  keys resizes non-proportionally.
• The  key resizes the selections boundaries (not the contents of the selection).

3. Click outside the selection or press the  keys to deselect.

Deleting the selection

You may remove the selection and add it to the Clipboard or simply remove it from the 
image permanently.

Deleting to the Clipboard

To delete the selection but add it to the Clipboard, click the  button or press the  
keys. The selection will be removed from the image, but will be available to paste from the 
Clipboard.

Deleting selection permanently

To completely remove the selection image, simply click the  button or press the  key.

Shift

Ctrl

Alt

Ctrl + D

Ctrl + X

Delete
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Using selections for drawing

You may use selections to function as masks when drawing. When a selection is made, the 
Drawing tools will only be applied within the selected area.

To draw within a selection, do the following:

1. Disable the Auto Selection mode, if necessary, by clicking the  button on the Draw 
Tools toolbar.

2. Make a selection.

3. Select a Draw tool and begin drawing. You may draw beyond the selected area, but only 
the pixels within the selection will be visible.

4. Continue to select draw tools and create the image within the selection.

5. Press the  keys to deselect.

Selection area

Visible image within the selection

The faded area will not be displayed in your image. The Fade area
is to demonstrate that you may draw beyond the selection.

Ctrl + D
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Working with 
Layers
Viscosity allows you to use layers when creating still graphics and animations. Layers 
function as transparent sheets on which you draw. Each layer may contain separate images, 
which is useful when editing. Because layers function as transparent sheets, each layer’s 
image data appears as one image file as you draw. Layers provide advantages for working 
because you can draw or edit parts of complex images without affecting the other layers. 

In addition, you may can add different special effects or transitions to different layers, letting 
you create simultaneous animated actions. For animations, any layer that you add, move, 
remove, or merge will affect every frame as well.

Finally, saving the still graphic or animation in the Viscosity native format (*.vsc), preserves 
the layers that you have created for editing later. 

Using Layers Page

The Layers Page organizes all the layers in your still graphic or animation. The Layers Page 
allows you to add, name, move, merge, hide, and remove layers. When you open a new 
image, the Layers Page displays one layer: Background. The Background layer has a yellow 
arrow displayed next to it. This arrow indicates which layer is active. The active layer is 
where drawn objects and edits will be applied.

In addition, the active layers’ blend and opacity is set on the Layers Page. For more 
information, see Setting layer properties on page 41.

Layer name

Exclusive/non-exclusive

Display/hide

Layer selection arrow

Blend drop-down
Opacity slider

control
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Adding layers

You may add layers by doing the following:

• From the Layer menu, choose New.
• On the Layers Page, right-click and choose New from the shortcut menu.
• Press the  shortcut keys.

Viscosity names the added layers in chronological order: Layer0, Layer1, Layer2, and so on. 

Selecting a layer

The yellow arrow on the Layers Page indicates which layer is active. The active layer is 
where all subsequent drawn pixels and edits are applied.

To activate a different layer to which drawn pixels will be applied, do one of the following:

• On the Layers page, click the desired layer.
• From the Layer menu, choose the desired layer.

Ctrl + L

Active layer

Active layer
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Naming layers

Viscosity names layers as you add them in chronological order. However, you may change a 
layer’s name at any time by doing the following:

1. Select the layer that you want to rename.

2. Triple-click or press the  key to reveal the layer’s text box (The Layers Page needs to be 
active to use  the key).

3. Enter the name and press the  key to save the layer name. 

4. Repeat steps 1-3 to rename other layers.

Rearranging layers

The layers and their image data may be rearranged at any time. You may move layers by 
dragging and dropping or using the shortcut menus.

Dragging layers on the Layers Page

1. Select the layer to move.

2. Drag the layer to the preferred position. As you drag the layer, its “ghosted image” 
appears.

3. Release the mouse to set the new layer position.

F2

F2

Enter

Before the layer is moved After the layer is moved
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Moving layers with the shortcut menus

You may also rearrange layers via the Layers Page shortcut menu by doing the following:

1. Select the layer to move.

2. Right-click the layer and choose the desired move command.

Duplicating layers

You may duplicate layers and their images. When selecting multiple layers to duplicate, you 
may select sequential layers by pressing the  key or non-sequential layers by pressing the 

 key. 

To duplicate layers, do the following:

1. Press either the  or  key.

2. On the Layers Page, click to select the layers to duplicate.

3. Right-click and drag the layers to the desired position. As you drag the layers, you will see 
their “ghosted” images.

4. Release the mouse and a shortcut menu will appear.

5. Choose to either copy the layers before or after the layer where you released the mouse. 
The layers will be copied to the new positions.

Shift

Ctrl

Shift Ctrl
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Hiding/display layers

The Layers Page contains two toggles for each layer: Display and Exclusive. The Display 
toggle, when clicked, will either hide or display the active layer. The Exclusive toggle is 
useful for quickly hiding all other layers except the active layer. 

The toggle’s icons indicate the current state of the control. To use these toggles, simply click 
them to enable or disable.

Setting layer properties

The Layers Page controls a layer’s properties. Each layers’ properties may be set 
independently from the others. You may set the layers’ Blend mode and Opacity setting.

Choosing a Blend mode

Viscosity stacks the image layers so that you may work on independent pixel data. However, 
the Blend mode enables you to combine a layer’s image data in various ways with the 
underlying layers while keeping them separated. For example, in the below example, 
selecting the Darken Blend mode for the Blue Polygon layer means its colors are blended with 
the Red Square, Green Circle, and Background layers.

Note: You may still work with the underlying 
layers after a Blend mode has been chosen.

Layer Visible

Layer Hidden

Exclusive toggle disabled

Exclusive toggle enabled

Before the Blend is applied Select the Blend type After the Blend is chosen
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Setting the layer’s opacity

Viscosity allows you to set a layer’s opacity so that underlying layer images can show 
through. The Opacity slider affects all pixel data on the active layer. Select the layer and 
move the Opacity slider to set its transparency. A layer setting of 100% is fully opaque.

Assigning images to specific layers

You may specify which layer an image will be assigned prior to drawing it or after it is drawn.

Assigning a layer prior to drawing

Before you draw an image, simply click the layer on the Layers Page or choose the layer’s 
name from the Layer menu.

Assigning a layer after drawing

After a drawn image is in place, you may move it to a different layer by doing the following:

1. Select the layer on which the image that you want to move is assigned. 

2. Using a selection tool, select the image. For more information, see Making a selection on 
page 30.

3. From the Selection menu, choose Float. This step leaves a copy of the selection on its 
original layer and floats a copy. To completely reassign the selection to a new layer, copy 
and paste it. For more information, see Copying and Pasting the selection on page 34.

4. On the Layers Page or from the Layers menu, choose the layer to which the floating 
selection will be assigned.

5. From the Selection menu, choose Defloat or click outside of the selection to assign the 
image to the new layer.

Before the Opacity is applied Set the Opacity After the Opacity is set
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Merging layers

You may merge images on different layers into one. The layers are merged based on their 
stacked order. Viscosity does not create a new layer, but uses the active layer to which the 
yellow arrow is pointing. 

When selecting multiple layers to merge, you may select sequential layers by pressing the 
 key or non-sequential layers by pressing the  key. 

To merge layers, do the following:

1. Press either the  or  key.

2. Click the layers that you want to merge. The last layer you select will be the active layer 
on which the others will be combined.

3. Merge the layers by doing one of the following:

• On the Layers Page, right-click and choose Merge All Selected.
• From the Layers menu, choose Merge and then Merge All Selected.

Note: You may merge all layers or only the 
visible layers by choosing Merge All or Merge 
All Visible from the Layer menu or Layer Page 
shortcut menu.

Shift Ctrl

Shift Ctrl

Layers to be merged.

Layer name and position where
merged pixels will appear.
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Deleting layers

You may delete single or multiple layers. When you delete a layer, all the image data on that 
layer will be removed.

When selecting multiple layers to delete, you may select sequential layers by pressing the 
 key or non-sequential layers by pressing the  key. 

To delete layers, do the following:

1. Press either the  or  key.

2. Click the layers that you want to delete.

3. Delete the layers by doing one of the following:

• On the Layers Page, right-click and choose Delete.
• From the Layers menu, choose Delete.

• Press the  key. Viscosity will display a confirmation dialog.

Shift Ctrl

Shift Ctrl

Delete
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Working with 
Animations
Viscosity allows you to create animations from scratch by drawing on multiple frames at 
once, converting still graphics into animations, or opening existing animations for editing. 
An animation is a file that contains individual frames. Each frame is a single-image drawing 
or photograph. When the file is played back, the image appears to have motion because each 
frame is displayed in quick succession.

You may apply transitions and filter effects to frames in an animation to make them appear 
as naturally occurring events when the animation is played back.

Creating a new animation

When starting a new animation file, Viscosity allows you to set its properties prior to 
working. Usually, the intended use of the animation determines these properties. However, 
you may change the animation’s properties at any time.

To create a new animation, do the following:

1. Access the New Document dialog doing one of the following:

• From the File menu, choose New.
• Click the  Toolbar button.
• Press the  shortcut keys.

2. Once the New Document dialog appears, click the Animation icon.

Ctrl + N
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3. Set the animation’s Image, Color, and Animation Properties. Or, to use the default 
settings, skip to step 4. The following properties may be changed after the file is open.

4. Click the OK button and Viscosity will create a new image area where you begin creating 
an image.

Image Properties
Bit-depth Determines the amount of color that is available for each pixel as you draw.
Width Sets the width in pixels for the image area.
Height Sets the height in pixels for the image area.
Resolution Sets the sharpness of the image area.

Color
Background color Select the preferred color to use as the backdrop for the image area.
Background opacity Determines the opacity (transparency) for the background color. (If the opacity 

slider is set to 100%, then the background color will be solid.)

Animation
Length Sets the number of frames for the animation.
Frame delay Sets the time delay between frames during animation playback

Image area

Animation Reel

Transport bar
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Converting a still graphic to an animation

You may convert a still graphic into an animation file by doing the following:

1. Open the still image that you want to convert.

2. From the Animation menu, choose Create Animation. Viscosity will create a new 
Animation Image area with the still graphic appearing on the first frame of the 
Animation Reel.

After the still graphic has been converted, you may insert frames as needed. For more 
information, see Adding frames on page 48.

Working with frames

Frames are individual drawings that make up the animation. You may draw, edit, and set 
properties to a single selected frame or multiple selected frames at once.

Selecting frames

To work on specific frames, you select them on the Animation Reel. When frames are 
selected, you may draw and edit on them simultaneously. You may select multiple sequential 
frames by pressing the  key and multiple non-sequential frames by pressing the  key.

To select frames, do the following:

1. Press either the  or  key to select multiple frames.

2. Click the desired frame(s) on the Animation Reel.

Shift Ctrl

Shift Ctrl

Animation Reel

Selected
Frames

Non-selected
Frames
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Adding frames

You may add frames to the Animation Reel by doing the following:

1. Select the frame where the new frame(s) will be added.

2. From the Animation menu, choose Insert Frames. The Insert Frames dialog will appear.

3. Set the frame’s properties using the following controls:

• In the Length field, enter the number of frames to be added.
• In the Frame Delay field, specify the desired delay time for the newly added frames. 
• In the Creation Method area, click either Create empty frames or Create duplicate copies of 

current frame.
• In the Insert area, click either Insert before current frame or Insert after current frame. 

4. Click the OK button to add the frames to the Animation Reel.

Copying frames

You may create copies of frames and “paste” them on the Animation Reel. Copying frames 
allows you to insert duplicated frames anywhere on the Animation Reel. 

To copy and insert frames, do the following:

1. On the Animation Reel, select the frame(s) to copy.

2. Right-click and drag the frame(s) to the desired position on the Animation Reel. You will 
see the frames’ ghosted image as you drag them.

3. Release the mouse and a popup menu will display.

4. From the popup menu, choose either Copy Before or Copy After.

Viscosity inserts frame duplicates and shifts (if necessary) existing frames. Also, the number 
of animated frames will increase to include the copied frames. 

Right-click and drag
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Moving frames

Viscosity allows you to easily move one or more frames on the Animation Reel by doing the 
following:

1. On the Animation Reel, select the frame(s) to move.

2. Click and drag the frame(s) to the desired position on the reel.

3. Release the mouse and the frames will be removed from their old position and inserted 
into the new position. The new position is prior the existing frame that was selected 
when the mouse was released.

Note: You may also move frames by right-
clicking and dragging. This method displays a 
popup menu when you release the mouse. 
Select either Move Before or Move After.

Removing frames

You may remove frames from the Animation Reel by doing the following:

1. Select the desired frame(s) to remove.

2. Remove the frames in one of the following ways:

• From the Animation menu, choose Delete Frames.
• Right-click and choose Delete from the shortcut menu. A confirmation dialog will 

appear. Click the Yes button to remove the frames.
• Press the  key. A confirmation dialog will appear. Click the Yes button to remove 

the frames.
The selected frames will be removed from the Animation Reel.

Right-click
and drag
to move
frames

Delete
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Setting frame properties

Each frame may have its properties set independently of the other frames on the Animation 
Reel. For example, some of the properties that you may set include frame delays, filters 
effects, and deformations. By setting frame properties independently, you can create 
animated effects without using extra frames.

Naming frames

As an option, you may name frames on the Animation Reel. Naming the frames can help 
you identify the different parts of the animation. You may add names to a single or multiple 
frames simultaneously.

To name or rename a frame, do the following.

1. Select the frame(s) that you want to name.

2. From the Animation menu, choose Change Frame Name. The Change Frame Name 
dialog appears.

3. In the Frames to modify area, click the radio button based on the frames that were selected 
in step 1 or to change which frames get names.

4. In the Frame Name field, enter the desired frame name. 

5. Click the OK button to assign the name.

The frame name appears beneath the respective frame(s) on the Animation Reel.

Note: This dialog also has a list of Presets. 
Presets are saved settings that allow you to 
quickly name frames.

Click radio
button in 
which the 
name will apply

Enter frame
name

Frame name
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Adjusting frame delays

You may adjust frame delay on single frames or on multiple frames simultaneously. Frame 
delays may be set in milliseconds, seconds, Frames per second (fps), or using SMPTE values.

To set frame delay properties, do the following:

1. Select the desired frame(s) on the Animation Reel.

2. From the Animation menu, choose Change Frame Delays. The Change Frame Delay 
dialog will appear. 

3. In the Frames to Modify area, select the appropriate radio button depending on the frames 
selected in step 1 or to change the frames that get the new frame delay.

4. In the Modify Frame Delay area, choose one of the following:

• Change to adjusts the frame delay to the value that you enter.
• Increase by adjusts the frame delay by adding the value that you enter to the current 

property setting. 
• Decrease by adjusts the frame delay by subtracting the value that you enter from the 

current property setting.
• Scale by adjusts the frame delay by multiplying the percentage value you enter with the 

current property setting.

5. Click the OK button to set the new frame delays.

Note: This dialog also has a list of Presets. 
Presets are saved settings that allow you to 
quickly change frame delays.

Available delay settings
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Using Effects and Transitions on frames

Viscosity enables you to apply filter Effects and Transitions to your animations. You may 
apply Effects and Transitions to a single selected layer or multiple selected layers. Transitions 
allow you to affect image data across frames in the animation.

Using filter effects

Filters are effects that transform a layer’s image data. Viscosity offers many filters that may be 
used to affect image data on layer(s). In addition, you may use the filters to affect image data 
on various frames simultaneously. As an example, you could use the Effects Blur filter to add 
an out-of-focus look to a drawing or entire animation frame.

You will find these filters on the Filters menu. The Filters are divided into groups: Effects, 
Color Adjustments, Deformations, and Render. 

When you select a filter, the associated dialog appears with controls and a preview pane. 
Adjust the controls to achieve the desired look. 

The following procedure describes using the Blur Effects filter. However these steps may be 
used for any of the available filters.

To use filters on frames, do the following:

1. On the Animation Reel, select the frame(s) in which to add the filtered affect.

2. On the Layers Page, select the desired layer(s) that the filter will be applied.

3. From the Filters menu, choose Effects. The Effects dialog appears.

Effects dialog

Filter drop-down

Filter controls

Preview pane

(Controls are
based on the 
selected filter.)
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4. In the Layers to Modify area, click the radio button based on the layers that you selected in 
step 2 or to change which layers get the effect.

5. In the Frame to Modify area, click the radio button based on the frames that you selected in 
step 1 or to change which frames get the effect.

Note: You may choose a filter type from the 
Filter drop-down list. The chosen filter will 
display its associated controls and fields.

6. Set the Blur properties by using the Radius slider. The preview area will update the Blur 
effect based on the slider’s settings.

7. Click the OK button to apply the Blur filter.

Using variable parameters with filters

When using filters, you can specify starting and ending properties. This option allows you to 
change the filter’s effects (how it affects the image) over the length of selected frames. For 
example, you could make an image “travel” across the animation by using the variable 
parameters of the Move Effect. 

You may animate swirls, ripples, color adjustments, and blurs just to name a few. The 
following procedure uses the Move Deformation filter as an example. These procedures may 
be used for any filters that have configurable controls.

To use the Move deformation filter’s variable parameters, do the following:

1. Make sure that the image you want to move is on all the selected Animation Reel frames.

2. From the Filters menu, choose Deformations and then Move. The Deformations dialog 
will appear.

3. On the dialog, confirm that Move appears in the Name drop-down list and click the Vary 
Parameters ( ) button. 

Select layers to apply the filter Select the frame to apply the filter
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In the Filter area, you will see a Start and End tab. The Start tab sets the filter properties on 
the first selected frame and the End tab sets the properties for the last selected frame.

4. Set the filter properties on the Start and End tabs. The preview will update and emulate 
playback based on the property settings.

5. Click the OK button to apply the Move filter’s variable parameters to the selected frames. 

The selected frames between the start and end frame will display the filter’s gradual changes 
to the image data.

Note: Variable parameters is only available 
with filters that have configurable settings.

Vary Parameters enabled
Vary Parameters button

In this example, the text
will move from top to 
bottom on the selected
frames.

After the Move filter is
applied, you will see the 
incremental movements
displayed on each frame
on the Animation Reel.

The image area only displays 
one frame at a time. The 
multiple increments shown are
only to demonstrate the text’s
motion over the ten frames.
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Using frame transitions

Viscosity allows you to add a transitional effect between frames. You may add a transition 
that will affect all the layers in the animation or only the selected ones on the Layers Page.

You may add the following transition types and configure their properties:

You add transitions from the Transition Effects dialog. This dialog has a preview area that 
reflects the chosen transition and the controls that have been set.

Adding a transition on all layers

When adding a transition to all layers, you may choose to have Viscosity calculate the 
required number of frames or specify the desired number of frames yourself.

To add a transition on all layers, do the following:

1. On the Animation Reel, select the frame in which you want the transition to start. By 
selecting one frame, you ensure that existing frames are not overwritten with the 
transition frames.

2. From the Animation menu, choose Transition. The Transition Effects dialog appears.

Transition Description Transition Description
Clock Adds a clockwise or counter-clockwise 

wipe from the first frame to the last 
frame in the sequence.

Slats Adds lines, like a window shade, that gradually 
hide the first frame while revealing the last frame 
in the sequence. 

Dissolve Adds a pixelated erosion that slowly 
hides the first frame while revealing the 
last frame in the sequence.

Slide In/Out Moves either the first or last frame off the 
“screen” to reveal next frame in the sequence 
(first or last frame). 

Fade Slowly fades out the first frame while 
fading in the last frame in the sequence.

Wave Reveals the last frame in the sequence with a 
shimmer effect.

Mosaic Adds random tiles that gradually hide 
the first frame while revealing the last 
frames in the sequence.

Wipe Adds a faded wipe from the first frame to the last 
frame in the sequence

Animation Reel

Selected
Frame
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3. In the Layers to Modify area, click the All Layers radio button.

4. From the Filter drop-down list, choose the desired transition. The transition that you 
select will have related controls appear that you may change.

5. Set the transition’s properties using its associated fields and sliders. The preview area will 
update and play back the transition’s effect based on the property settings.

Optionally, you may specify how many frames to add from the Length menu and the added 
frames’ delay setting on the dialog. If you set the length field in milliseconds, seconds, or 
time, Viscosity will calculate the required number of frames for you.

6. Click the OK button to apply the transition.

Note: If multiple frames are selected on the 
Animation Reel, when you apply a transition 
to all layers, the inserted transition frames will 
overwrite those selected frames.

Transition Effects dialog

Preview pane

Transition

Trans. controls

(Controls are
based on the 
selected trans.)

drop-down
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Adding a transition to single or multiple layers

You may add a transition to a single or multiple layers. The transition will occur over the 
number of frames that you select and only on the selected layer(s).

To add a transition to layer(s), do the following:

1. On the Layers Page, select the desired layer(s).

2. On the Animation Reel, press the  key and select a range of sequential frames. 

3. From the Animation menu, choose Transition. The Transition Effects dialog appears.

4. In the Layers to Modify area, click either the Single Layer or Selected Layers radio button.

5. From the Filter drop-down list, choose the desired transition. The transition that you 
select will have related controls appear that you may change.

6. Set the transition’s properties using the fields and sliders that are associated with it. The 
preview area will update and play back the transition’s effect based on the property 
settings.

7. Click the OK button to apply the transition.

Note: Transition “smoothness” relates to the 
number of frames selected on the Animation 
Reel. The more frames that are selected the 
smoother the transition.

Shift

Animation Reel

Selected
Frames
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Exporting and importing frames

Viscosity supports the exporting and importing of frames to and from the Animation Reel.

Exporting frames

You may export selected frames from the Animation Reel and save them as separate still 
graphics in the format of your choosing. Each exported still uses the entered frame name or 
the base name that you enter on the Export Frames dialog. 

If the frames are not named or you enter a base name, the exported frames numbered 
sequentially.

To export frames, do the following:

1. On the Animation Reel, select the desired frame(s) to export.

2. From the File menu, choose Export Frames. The Export Frames dialog appears.

3. From the Export Frames dialog’s Save as type drop-down list, choose the desired graphic 
format to which the frames will be exported.
WORKING WITH ANIMATIONS CHP. 5



59
4. In the Frames to Export area, you may specify which frames are exported, if other than the 
selected frames. 

• The Single Frame radio button indicates that only the first selected frame will be 
exported. 

• The Selected Frames radio button indicates that only the frames that you selected will be 
exported.

• The All Frames radio button indicates that the entire Animation Reel’s Frames will be 
exported as separate still graphics.

5. Select a naming option for the exported frames:

• The Use frame names radio button indicates that all exported still graphics will use the 
frame’s name. If the frames have not been named, the name “Untitled” will be used and 
the frames will be numbered sequentially. 

• The Specify base name radio button indicates that all exported still graphics will use the 
name that you enter and number the exported frames.

Importing frames

You may import still or animated frames from other files and insert them anywhere on to the 
Animation Reel. Inserting frames at the beginning or middle of the Animation Reel will 
shift any existing frames to occur later during playback.

To import frames, do the following:

1. On the Animation Reel, select the frame where the imported frame(s) will be inserted.

Animation Reel

Selected
Frame
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2. From the File menu, choose Import Frames. The Import Frames dialog appears.

3. From the Import Frames dialog, navigate to the file that you want to import. 

4. Click the Open button to insert the frame(s).

The selected file will be inserted at the frame position that you selected on the Animation 
Reel.

Playing back the animation

The image area for animations includes a Transport bar. This bar functions similarly to 
playback buttons on a VCR. As you work on the animation, you may play back frames to 
check your work. 

Button/Name Description Button/Name Description

 Go to first frame
Selects the first frame on the 
Animation Reel.

 Stop
Stops animation playback.

 Go to Prev. frame
Selects the previous frames on the 
Animation Reel.

 Play
Starts play back from selected 
frame.

 Go to Next frame
Selects the next frame on the 
Animation Reel.

 Play selected
Plays back only the selected frames 
on the Animation Reel.

 Go to Last frame
Selects the last frame on the 
Animation Reel.

 Loop playback
Continues play back of the 
animation.

Transport bar
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A

Frequently 
asked Questions
The following questions and answers address common issues when using Viscosity. These 
questions are related to topics and procedures covered in this Start Guide. If the issue you 
seek is not in this Appendix, please refer to the online help or visit our website at 
www.sonicfoundry.com/support/tech/faq.asp.

Drawing questions

Why when trying to use a drawing tool nothing happens?

This may be happening for a number of reasons:

• Check that you in fact have a drawing tool selected.
• Make sure you are not using a transparent color.
• Check that the brush properties are not transparent, a Density of 0%, or a large Step 

setting.
• Check the Layer page to confirm that you are drawing on an active layer. You may be 

drawing on an layer that is hidden.
• If a selection exists, make sure you are drawing within it. 

For more information, see Using drawing tools on page 19.

Why when drawing on the image, it only affects a certain area?

You may have a hidden selection present on the image. You can show the selection or 
remove it entirely through the Selection menu. For more information, see Using selections for 
drawing on page 36.
FREQUENTLY ASKED QUESTIONS
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Why do drawn shapes have moving outlines instead of solid lines?

Dashed outlines (marquees) indicate that a selection tool is being used. The icons for both 
types of tools can look similar, but the selection tool icons have dashed lines. For more 
information, see Making a selection on page 30.

Why do line edges look jagged?

Enable the Anti-alias ( ) button, located on the Draw Tools toolbar. When anti-aliasing is 
enabled, Viscosity adds a subtle row of transition pixels on each side of a drawn line. These 
transition pixels result in smoother line edges. For more information, see Setting the Selection 
mode on page 30.

How do I use the Text tool to add text?

1. Click the Text tool ( ) button. 

2. Access the Tools Page and type text in the box provided. To change the font and size, you 
must first select the text.

3. Move the cursor to the desired location on the image and click to add the text.

For more information, see Using text on page 27.

How do I draw shapes without outlines?

You can eliminate the appearance of an outline in a number of ways: 

• Choose No Outline on the Current Color bar. 
• Set the brush opacity to 0% on the Brush Page
• Make the Outline and Fill colors exactly same. 

The outline will still be used, but the shape will draw as one color.

For more information, see Disabling outlines and fills on page 23.

Can I change a shape or text after it has been added to the image?

Shapes/text that you draw in Viscosity are not objects, so they cannot be edited after they 
have been applied to the image. 

However, Viscosity has multiple undo capability; if you are unhappy with a drawn item, click 
the Undo ( ) button and try again. 

In addition, we recommend that you draw shapes on different layers; this way, you may 
delete layers without altering the rest of the image data. For more information, see Adding 
layers on page 38.
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Selection questions

How do I turn off automatic selections when drawing?

When the Toggle Auto-Selection ( ) button is enabled on the Draw Tools toolbar, all 
shapes you draw are given selection outlines. Click this button to disable Auto-Selection. 
For more information, see Setting the Selection mode on page 30.

Why does a selection’s outer edges not correspond with the selected 
image?

When the Apply Brush To Selection ( ) button is enabled on the Selection Tools toolbar, 
the outer edges of selections derive their properties from the Brush Page settings. To make a 
selection correspond exactly with the box you drag, click this button to disable the brush 
application. For more information, see Setting the Selection mode on page 30.

Why when moving a selection, the edges of its former location seem 
blurred?

When the Anti-alias Selection ( ) button is enabled on the Selection Tools toolbar, a 
subtle row of transition pixels is automatically added to smooth jagged edges (especially 
useful for circular selections). Click to disable this feature from future selections. For more 
information, see Setting the Selection mode on page 30.

How can I prevent selection handles from displaying?

Grab handles appear on all selections when you have the Toggle Selection Handles ( ) 
button enabled. If you click this button again, all handles disappear. For more information, see 
Setting the Selection mode on page 30.

Why when copying and pasting a selection to a new frame, the pasted 
area appears on every frame yet does not appear on the Animation Reel?

A pasted selection remains floating until you remove its boundaries or draw within it. To 
make it appear on only the selected frame(s) and on the Animation Reel, you need to 
defloat it. For more information, see Floating/defloating the selection on page 33.
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Why when cutting, copying, or moving a selected area the image data is 
not being affected?

Make sure that you have the image data’s correct layer selected on the Layers Page. 
Selection outlines appear in the Image Area regardless of what layer is selected on the Layers 
Page. For more information, see Editing the selection on page 34.

Is there a way to move images on the same layer but on different frames? 

1. Select the layer with the image data and select all frames.

2. From the Filter menu, choose Deformations and then Move.

3. Set the horizontal and vertical offsets. Make sure the Selected Frames radio button is 
selected at the top of the dialog box.

4. Click the OK button.

For more information, see Using variable parameters with filters on page 53.

Color questions

What does a checkered “color” swatch mean?

Viscosity uses checkers to represent transparency. If a color is completely transparent, the 
checkered background is all that appears. When colors are more opaque, the checkered 
background is “filled” with the desired color.

How do I set an Outline or Fill color when the Current Color Toolbar’s 
swatches display icons instead of colors?

Double-click the Outline or Fill swatch to display the Window’s Color picker dialog. Click 
the desired color. For more information, see Using outline and fill colors on page 21.

Why when I change the background color, the color is not applied?

This is by design. The background color is used by Viscosity to determine the color that 
needs to be used when erasing and doing other operations.
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Interface questions

Why does the online help not display?

Viscosity uses HTML based help which requires Internet Explorer 4.0 or higher to be 
installed.

How do I display Toolbars and Pages?

You may access all Toolbars and Pages from the View Menu. Check marks next to View 
menu items indicate that the item is visible.

Why do the Layer’s Page Visible/Not Visible icons not work properly?

One of the layers may be exclusive, meaning that only this layer is visible (and all other 
layers are rendered invisible). You can only make the rest visible again by changing the icon 
beside the exclusive layer to Not Exclusive. For more information, see Hiding/display layers on 
page 41.
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